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1 About PSTWay 

PSTWay allows users of Microsoft Outlook Web Access (OWA) to access Outlook personal folders stored in 
PST files on the corporate network. Users are granted access to their PST files by the FileWay Administrator. 
Users may add and remove emails from their PST files. Refer to PSTWay End-User Notes  on page 99  to see 
PSTWay in action. 

PSTWay integrates with FileWay. Specifically, PSTWay and FileWay have 2 components in common: FileWay 
Back End and FileWay Manager. If you already have FileWay installed in your organization, you do not need to 
reinstall it; however, you must upgrade to version 3.4. The PSTWay Installer includes FileWay Version 3.4. 

If you  have not installed FileWay, note that FileWay Back End and FileWay Manager are included with 
PSTWay so that you may install them before installing PSTWay. 

PSTWay comprises the following: 

·  PSTWay Components for OWA Servers 

·  PSTWay Service for Outlook Server 

·  FileWay Back End which includes FileWay Manager 

PSTWay components provide the functionality that allows users to access their PST files stored on the corporate 
network.  FileWay Back End provides the user access controls to resources on the network.  FileWay Manager is 
a Windows application that Administrators use to specify users’ access rights for corporate drives and shared 
folders. 

All components can be installed together on the same server or separately depending on the configuration you 
choose.  From a performance point of view, there is no difference whether you install on one or multiple servers.  
However, if you have multiple servers hosting OWA, then PSTWay Component for OWA Server must be 
installed on each server. 

Note that if FileWay Version 3.4 components are already installed in your organization, you do not need to install 
them again. If want to share your existing FileWay components with PSTWay, you must upgrade to FileWay 3.4 
components. 
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2 Requirements 

This chapter describes the minimum system requirements for installing PSTWay components. 

2.1 PSTWay Software Requirements 

2.1.1 Exchange 2003 Server(s)  

·  Microsoft WindowsTM 2008 Standard or Enterprise Edition 

·  Microsoft WindowsTM 2003 Server Standard or Enterprise Edition Microsoft Internet Information 
Server TM (IIS) 6 

·  Microsoft .NET 2.0 or later 

·  Outlook Web Access configured and running 

·  Member of the (Windows) Domain 

2.1.2 Designated Outlook Server  

·  separate server hosting Outlook 2003 or 2007 with any service pack 

·  Microsoft .NET 2.0 or later 

·  Outlook tested connecting to Exchange 

·  Member of the (Windows) Domain 

2.1.3 FileWay Back End and FileWay Manager Requirem ents 

·  Microsoft WindowsTM 2003 or 2008 Server Standard, Small Business, or Enterprise Edition, any 
service pack 

·  Internet Information Sever (IIS) 6.0 or later 

·  Microsoft Outlook Web Access (OWA) 2003 any Service Pack 

·  Microsoft .NET 2.0 

·  Member of the (Windows) Domain 

2.2 Supported Browsers 

PSTWay supports the following browsers: 

·  Internet Explorer 6.0 and up (Windows) 

·  Firefox version 1.5 and up (Macintosh and Windows)  
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2.3 Network Requirements 

The PSTWay and FileWay components must be installed in an environment where they are able to 
communicate with each other via TCP/IP and Windows File Sharing. All components will need to be running as 
members of a Microsoft Windows Domain. 

3 Preparing for Installation 

The following steps should be followed before installing PSTWay: 

1. Select the servers on which you will install each component. 

2. Create a PSTWay domain user account to be used by PSTWay. 

3. Install Outlook 2003 or 2007 with any service packs on the designated Outlook Server. 

4. Install Microsoft .NET 2.0. 

5. Perform additional steps prior to installing on a Domain Controller. 

6. Prepare IIS 6 on FileWay BackEnd Server. 

Each step is explained below in further detail. 

3.1 Selecting Servers 

Before installing the software, you should select the server(s) on which you will install the various PSTWay 
components. In making your decision, there are various factors to consider such as the following: 

·  Do you want to install all PSTWay components on a single computer or multiple computers? 
There is no performance advantage to installing on one or multiple servers.  The decision is 
mainly based on preference. 

·  Is FileWay Back End already installed? If it is, decide whether you want to install a new instance 
of FileWay Back End or whether you want to re-use the existing instance. If you decide to re-
use the existing instance, the installer will upgrade FileWay Back End to version 3.4.  If you 
decide to install a new instance of FileWay Back End, the installer will install it automatically. 

·  Is MS Exchange installed on a single server or on multiple servers? If Exchange is installed on 
multiple servers, you have to install the PSTWay Component for OWA Server on each server 
that has OWA installed on it. 

Note: Outlook is required because it provides the MAPI support required by PSTWay Service for Outlook.  
Since Microsoft does not support installing Outlook and Exchange Server on the same computer, Outlook must 
be installed on a separate server (or workstation) along with PSTWay Service for Outlook Server.  For details, 
refer to http://support.microsoft.com/kb/266418.  A server is preferred over a workstation because, among other 
reasons, servers are usually monitored and restarted in case of failure. 

The flowchart below summarizes the installation steps. 
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3.2 Creating PSTWay Admin Account 

The network administrator needs to create a user account in Active Directory for use by each component. Add 
the PSTWay Admin user to the Domain Admins Security Group. This account does not need access to anything 
on the existing network. 

The PSTWay Admin account must have Full mailbox access for all users who need to use PSTWay. To give 
the PSTWay Admin user Full mailbox access to another user, proceed as follows: 

1. Access Active Directory Users and Computers from a computer on which Exchange System Manager 
is installed. On an Exchange server, it can be invoked as follows:  Start > Programs > Microsoft 
Exchange > Active Directory Users and Computers . 

2. Ensure that the Advanced features view is set in Active Directory. To do so, proceed as follows: 

a. Right-click the organizational unit (OU) or container that holds the user accounts. 

b. Select View and ensure that there is a check mark next to Advanced Features . If not, click 
Advanced Features to set it. 

More tabs become available to you when looking at the properties of a user account. 
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3. Right-click a user in Active Directory and select Properties . The following dialog appears. 

 

4. Click the Exchange Advanced tab. 

5. Click the Mailbox Rights button. 

6. Click Add to add the PSTWay Admin user. 

7. Click OK. 

8. Select the PSTWay Admin account from the list at the top and then check the Allow box next to the 
Full mailbox access field. 
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9. Click OK twice to exit. 

Repeat the procedure for all users who need access to PSTWay. If there are many users who need access to 
PSTWay, you can use a tool called ADModify to modify this attribute for multiple users at the same time. Refer to 
Microsoft Product Support Services for more information about ADModify. 

3.3 Installing Outlook 2003 or 2007 on the Designat ed Outlook Server 

Install Outlook 2003 or 2007, along with service packs, on a server (or workstation) before installing PSTWay. 
This needs to be installed on a server that does NOT have Exchange installed on it. Only the minimal 
components are required. Refer to Microsoft Product Support Services for instructions explaining how install 
Outlook 2003 or 2007. 

Outlook 2003 or 2007 must not be installed on a server hosting MS Exchange because Microsoft does not 
support installing Microsoft Outlook and Microsoft Exchange Server on the same computer. For details, refer to 
http://support.microsoft.com/kb/266418. 

3.4 Installing Microsoft .NET 2.0 

Microsoft .NET 2.0 must be installed on all servers hosting PSTWay software before you install PSTWay. Refer to 
Microsoft Product Support Services for instructions explaining how install .NET 2.0.  

3.5 Performing Additional Steps Prior to Installing  on a Domain Controller 

Read this section only if you are planning to install PSTWay on a domain controller; otherwise, skip to the next 
section. 

Note: It is recommended that PSTWay be installed on a member server, not on a domain controller. 

FileWay supports Microsoft .NET Framework v2.0, but when it is installed on a domain controller, an Access 
Denied error occurs when trying to browse FileWay sites. This is because the worker process for Microsoft® 
ASP.NET (Aspnet_wp.exe ) runs under the local machine account to restrict access to domain resources and 
provide a more secure environment. 

On a domain controller, all user accounts are domain accounts and not local machine accounts, so 
Aspnet_wp.exe fails because it cannot find a local account named localmachinename\ASPNET . To prevent 
this error, edit the <processModel> section of the Machine.config file to run the ASP.NET worker process 
under the Network Service account, instead of the machine account. 

Proceed as follows to give the Network Service account the correct permissions: 

1. Grant the Network Service account the Log on as a batch job right as follows: 

a. Click Start > Programs > Administrative Tools > Domain Co ntroller Security Policy . 

b. Expand Security Settings , expand Local Policies , and then click User Rights Assignment .  

c. In the list of policies, right-click the Log on as a batch job policy  and click Properties . 

d. If the Network Service  account does not appear in the Assigned To  list, click Add  to add this 
user account. 

Note: Repeat this process for Domain Security policy. 

2. Grant the Network Service account write access to the following directory: 
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\Windows\Microsoft.NET\Framework\V2.0.XXXX\Temporary ASP.NET Files\ 

This will allow the Aspnet_wp.exe process to write temporary files and classes to this directory. 
Proceed as follows: 

a. Navigate to the following directory: \Windows\Microsoft.NET\Framework\V2.0.XXXX\.  

b. Right-click the Temporary ASP.NET Files icon. 

c. Click Properties and then click the Security tab. 

d. Add the Network Service account and give it Modify permissions. Navigate to the following 
directory: \Windows\Microsoft.NET\Framework\V1.1.XXXX\  

e. Click OK. 

f. Ensure that the new Network Service account has access to all other files and directories that 
are necessary to serve ASP.NET pages. 

3. Grant the new PSTWay Worker account write access to the \Windows\TEMP\ directory. 

If you are running XML Web services, this will allow the Aspnet_wp.exe process to write temporary 
files and classes to this directory.  Proceed as follows: 

a. Navigate to the \Windows\TEMP\ directory in Windows Explorer and right-click the TEMP icon.  

b. Click Properties and then click the Security tab. 

c. Select the Network Service account from the list and select the Allow check box for Write 
permissions.  

d. Click OK. 

e. Ensure that the new Network Service account has access to all other files and directories that 
are necessary to serve ASP.NET pages. 

3.6 Allowing Active Server Pages and Active Server Pages .NET 

Part of the Windows 2003 security options in Internet Information Services (IIS) is to allow the administrator to 
enable Active Server Pages (ASP) and Active Server Pages .NET (ASPX) or not. Since PSTWay is fully 
dependent on ASPs and ASPXs, those options have to be allowed on the IIS of Windows 2003 on any server 
that has PSTWay software installed (PSTWay includes PSTWay Components for OWA Servers, PSTWay 
Service for Outlook Server, and FileWay Back End with FileWay Manager),. 

To allow ASPs and ASPXs on IIS 6, proceed as follows: 

1. Click Add Remove Programs > Add Remove Windows Components . 

2. Click Application Server  then click the Details  button. 

3. Select ASP.Net  (if not selected) then click OK followed by Next  and complete the installation process. 

Note: If ASP.Net is already selected, you can exit the setup without having to complete. 

4. Click Start > Administration Tools ->Internet Information  Services (IIS) Manager . 
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5. Click the Web Service Extensions  in the tree. 

6. On the right-hand side, there appear three columns containing web service Extension  and Status . 

7. Read the status of the Active Server Pages  web service extension. 

If it is Prohibited , allow it (the allow button is to the left of the 3 columns) 

8. Read the status of the following web service extension. 

ASP .NET v1.1.xxx 
ASP .NET v2.xxxxx 

9. If they are prohibited, allow them too. 

4 Installing PSTWay 

 

 

Step 1: Install PSTWay Service on the designated Outlook Server or workstation you selected. Refer to 
Installing PSTWay Service for Outlook Server  below. 

Step 2: Install PSTWay Server Components using one of two approaches: 

·  Install all the server components required to run PSTWay on the same Exchange OWA server.  
Refer to Installing PSTWay Server Components on a Single Exc hange OWA Server  on 
page 11. 

·  Install PSTWay server components on separate servers. Choose this approach if you prefer a 
distributed architecture.  Refer to Installing PSTWay Components on Separate Servers  on 
page 40. 

Step 3: Upgrade existing FileWay components if applicable. 

4.1 Installing PSTWay Service for Outlook Server 

The PSTWay Service for Outlook Server component must be installed first. Proceed as follows:  

1. Run PSTWayOutlookServerSetup.msi  found in the folder named PSTWay Service for Outlook . 
The following dialog appears. 
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2. Click Next . The following dialog appears. 

 

3. Click Next to use the default location or click Browse to select a different location in which to install 
PSTWay Service for Outlook Server . The following dialog appears. 
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4. Click Next . The following dialog appears. 

 

5. Click Next . The following dialog appears. 
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6. Enter the user name and password you created in 3.2 Creating PSTWay Admin Account on page 5, 
then click OK. The following dialog appears. 

 

7. Enter the name(s) or IP address(es) of your Exchange mailbox server(s). 

 

8. Click Close . 

At this point, you are ready to install the server components required to run PSTWay on your Exchange server 
hosting OWA. Continue with Installing PSTWay Server Components on a Single Exc hange OWA Server . 
Alternatively, skip to Installing PSTWay Components on Separate Servers  on page  40. 

4.2 Installing PSTWay Server Components on a Single  Exchange OWA Server 

Proceed as follows to install all PSTWay server components on the same Exchange OWA Server. 

1. Run PSTWay Installer.exe  found in the folder named PSTWay Components for OWA Servers. 

Note: If the installer detects that FileWay Back End is already installed on the current server, the 
installer will attempt to upgrade FileWay Back End.  If this happens, please skip to Upgrading 
FileWay Components  on page 69.  Once you have upgraded FileWay Components, return to this 
procedure and start over.  
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If you are installing on a Domain Controller, the following message appears offering to display the 
pre-installation instructions for installing on a Domain Controller. 

This is the first thing you see, before the welcome page appears, if you are installing on a Domain 
Controller. 

 

If you click Yes, the following window appears displaying the pre-installation instructions for installing 
on a Domain Controller. 

 

If you are not installing on a domain controller, then the installation begins and a welcome dialog 
appears. 
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2. If you click on Pre-installation Instructions , it will open a txt file with the instructions; an example is 
shown below. 

 

3. Click Install PSTWay to begin the installation. The following dialog appears. 
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4. Click I accept the terms of the license agreement and then click Next . The following dialog appears. 

 

5. Click Single-Host: FileWay Back-end, PSTWay Component to install all PSTWay components on 
the same server. 

6. Click Next . 

��������	�
���
���
���������
�

The following dialog appears. 
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7. Enter the user name and password you created in 3.2 Creating PSTWay Admin Account on page 5. 

8. Enter the name or IP address of the designated Outlook Server on which you installed the PSTWay 
Service for Outlook Server component. Use the default Remoting Port unless port 9000 is being used 
by another application. 

9. Click Next . The following dialog appears. 

 

10. Click Go. The following dialog appears. 



PSTWay Administrator’s Guide 
 

 

 

Everywhere Networks Corporation Proprietary 

16 

 

11. FileWay Manager needs a SQL database in which to store data. You can search for and use an 
existing database on your network by clicking Get List . Setup will display a list of available databases 
in the SQL Servers field. If there are more than one database available, you can view them using the 
pull-down menu. Select a database and continue at the next step. 

Note 1: If you do not want to use one of the available databases, and prefer to create a new one, 
click Cancel to terminate Setup. Create the SQL database you need and re-start Setup. If you want 
to create a SQL database and do not have SQL Server, refer to Installing a SQL Server 2005 
Express Database Instance for FileWay  BackEnd on page 39. 

Note 2: If no databases are found, a message will appear (as shown in the figure below) asking if you 
want to install a database. Click Yes and then skip to Installing a SQL Server 2005 Express 
Database Instance for FileWay  BackEnd on page 39. 
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12. From the SQL Servers field, select the database that you want to use with FileWay then enter the 
Login ID and the password for the database. 

 

13. Click Connect . PSTWay Setup creates the FileWay database.  

14. Click Next . The following dialog appears. 
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After a short while, the following dialog appears. 

 

15. Click Next . The following dialog appears. 
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16. Click I accept the terms of the license agreement and then click Next . The following dialog appears. 

 

17. Enter the reference name that you obtained from Everywhere Networks in the Reference Name field. 

18. Enter your registration key in the Registration Key field. 

If you do not have a registration key and would like to evaluate FileWay, you can obtain a trial license 
by clicking Get Code . When you upgrade your trial license to a full license, you will not need to 
reinstall the software. There is a way to register the new key. 

19. Once you entered your registration key, click Next . The following dialog appears. 
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20. Click Next to use the default location or click Browse to select a different location in which to install 
FileWay. 

The following dialog appears ONLY if you have more than one web site; if it does not appear, 
PSTWay Setup will automatically be installed on the Default Web Site . 

 

21. Select the web site on which you want to install FileWay Back End services then click Next . The 
following progress dialog appears. 
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After a moment, the following dialog appears. 

 

At this point, FileWay Back End is installed and the installation of FileWay Manager is about to 
begin. Continue with the next section. 

����������
������
���������
�

22. Click Finish . The following dialog appears. 
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After a few moments, the following dialog appears. 

 

23. Click Next . The following dialog appears. 
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24. Click I accept the terms of the license agreement and then click Next . The following dialog appears. 

 

25. Enter your name and the name of your company and click Next . The following dialog appears. 
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26. Click Next to install in the default location or click Change to select a different location in which to 
install FileWay Manager . The following dialog appears. 

 

27. Click Install . The following dialog appears. 
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After a moment, the following dialog appears. 

 

�����
���������������
���������
�

28. Click Finish . The following dialog appears. 
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For information about the script modifier, refer to Troubleshooting on page 103. 

29. Click Next . The following dialog appears. 

 

30. Select the Everyone button if you want any user to be able to run the Script Modifier executable. 

Select Just Me if you only want the user who is currently logged on to the server to be able to run the 
Script Modifier executable. 

31. Click Next to use the default location or click Browse to select a different location in which to install. 
The following dialog appears. 
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32. Click Next . The following dialog appears.  

 

After a few moments, the following dialog appears. 
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33. Click Close and continue with the next section. 

������������
�
������������� �����
���������
�

The following dialog appears. 

 

After a few moments, the following dialog appears. 
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34. Click Next . The following dialog appears. 

 

35. Click I accept the terms of the license agreement and then click Next . The following dialog appears. 
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36. Click Next to use the default location or click Browse to select a different location in which to install. 
After a moment, the following dialog appears. 

 

After a moment, the following dialog appears. Press any key to continue. 
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After a moment, the following dialog appears. 

 

37. Click Finish . The following dialog appears. 
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38. Click Next . The following dialog appears. 

 

If you use Secure Sockets Layer (SSL) and/or Forms-Based Authentication (FBA) with Exchange, it 
will be necessary to configure PSTWay to use SSL and FBA as well. Refer to Upgrading FileWay 
Components 

If the PSTWay installer detects that an older version of FileWay has already been installed on the server on 
which you are running the installer, the installer will update the FileWay components. 

4.2.1 Upgrading FileWay Back End to Version 3.4 

To upgrade FileWay Back End,  proceed as follows: 
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1. Copy the PSTWay FileWay Backend Component folder to the appropriate server. 

2. Run FileWayBackEndServerSetup.exe from the PSTWay FileWay Backend Component folder. 

If the installer detects that FileWay Back End is installed on the current server, the following dialog 
appears prompting you to upgrade File Way to version 3.3. If you are not prompted to upgrade, it 
means that the current server does not have FileWay Back End installed or you do not need to 
upgrade. 

 

Click Yes. The following progress dialog appears. 

 

After a few moments, the following dialog appears. 
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3. Click Next.  The following status dialog appears. 

 

After a few moments, the following dialog appears. 
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4. Click Finish. 

At this point, FileWay Back End is updated. You should now upgrade FileWay Manager. 

4.2.2 Upgrading FileWay Manager to Version 3.4 

To upgrade FileWay Manager,  proceed as follows: 

1. Copy the PSTWay FileWay Backend Component folder to the appropriate server. 

2. Run FileWayManagerSetup.exe  from the PSTWay FileWay Backend Component  folder. 

If the installer detects that FileWay Manager is installed on the current server, a dialog appears 
prompting you to upgrade File Way to version 3.3. If you are not prompted to upgrade, it means that 
the current server does not have FileWay Manager installed or you do not need to upgrade. 

3. Click Yes. After a few moments, the following dialog appears. 
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4. Click Next.  The following dialog appears. 

 

5. Ensure that the Modify button is selected and click Next.  The following dialog appears. 

 

6. Click Next.  The following dialog appears. 
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7. Click Install.  The following status dialog appears. 

 

After a few moments, the following dialog appears. 
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8. Click Finish. 

At this point, FileWay Manager has been upgraded. Return to your point of origin…either Installing 
PSTWay Server Components on a Single Exchange OWA S erver  on page 11 or Installing 
PSTWay Component for OWA Servers  on page 47. 

Post-Installation Configuration Steps on page 69 for instructions describing how to configure PSTWay 
to use SSL. 

9. Click Next to continue. The following dialog appears. 

 

10. Click Finish . The following dialog appears. 
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11. Click OK. 

12. Restart the server. 

At this point, all PSTWay components are installed. Skip to Post-Installation Configuration Steps  on 
page 75. 

4.2.3 Installing a SQL Server 2005 Express Database  Instance for FileWay 
BackEnd 

This procedure only applies if you do not have a database and wish to install SQL Server 2005 Express to use 
with PSTWay. Once the database is installed and configured, you will need to re-start the PSTWay installation. 

This procedure assumes that you started installing PSTWay and were redirected to this section because you do 
not have a database installed. 

Proceed as follows to install SQL Server 2005 Express: 

1. Click Yes in the dialog below. 

 

The following dialog appears. 
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The Instance Name and Login ID fields are pre-populated. Enter a password and click Install . The 
following dialog message appears. 

 

2. Click OK. The following dialog appears. 

 

4.3 Installing PSTWay Components on Separate Server s 

This section applies if you prefer to install components in a distributed architecture or if FileWay Back End is 
already installed in your organization. 

PSTWay components should be installed in the following order: 

1. PSTWay Service for Outlook Server. 

2. FileWay Back End (which includes FileWay Manager) if FileWay is NOT already installed in your 
organization or if you prefer to use a separate instance of FileWay Back End specifically with PSTWay. 

3. FileWay Back End Upgrade to version 3.4 if FileWay is already installed in your organization 
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4. FileWay Manager Upgrade to version 3.4 if FileWay is already installed in your organization 

5. PSTWay Component for OWA Servers. 

4.3.1 Installing PSTWay Service for Outlook Server 

The PSTWay Service for Outlook Server component must be installed first. Proceed as follows: 

1. Run PSTWayOutlookServerSetup.msi  found in the folder named PSTWay Service for Outlook .  
The following dialog appears. 

 

2. Click Next . The following dialog appears. 
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3. Click Next to use the default location or click Browse to select a different location in which to install 
PSTWay Service for Outlook Server. The following dialog appears.  

 

4. Click Next . The following dialog appears. 

 

5. Click Next . The following dialog appears.  
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6. Click OK. The following dialog appears.  

 

7. Enter the name(s) or IP address(es) of your Exchange mailbox server(s).  

 

8. Click Close . 

At this point, you are ready to install FileWay Back End if it is not already installed in your organization. Continue 
at Installing FileWay Back End below. If FileWay Back End and FileWay Manager are already installed, you 
must upgrade to version 3.4; in this case, skip to Upgrading FileWay Components  on page 69.  
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4.3.2 Installing FileWay Back End 

This procedure applies if you do not already have an installation of FileWay Back End that you wish to use with 
PSTWay. If you already have an installation of FileWay Back End that you wish to use with PSTWay, skip to 
Upgrading FileWay Components  on page 69.  

To install FileWay Back End , proceed as follows: 

1. Copy PSTWay v2.0 for Exchange 2003 Setup folder to the appropriate server.  

2. Run PSTWay Installer.exe . 

The installation begins and a welcome dialog appears. 

 

3. Click Install PSTWay for Exchange 2003  to begin the installation. The following dialog appears. 
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4. Click I accept the terms of the license agreement  and then click Next . The following dialog appears. 

 

5. Click the FileWay Back-end  button and click Next . The following dialog appears. 
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6. Enter the user name and password you created in 3.2 Creating PSTWay Admin Account  on page 5. 

7. Click Next . The following dialog appears. 

 

8. Click Install  a new FileWay Back-end  and click Next . The following dialog appears. 



PSTWay Administrator’s Guide 
 

 

 

Everywhere Networks Corporation Proprietary 

47 

 

9. Click Go. The following dialog appears. 

 

10. Refer to FileWay Back End Installation  on page 14 for the rest of the installation procedure. Once 
FileWay is installed, install PSTWay referring to Installing PSTWay Component for OWA Servers  
on page 47. 

4.3.3 Installing PSTWay Component for OWA Servers 

This procedure assumes that FileWay Back End and FileWay Manager are already installed on a separate 
server and upgraded to version 3.4. 
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Note: If FileWay Back End is installed on the same server on which you are installing PSTWay, the procedure 
varies slightly. If applicable, the installer will prompt you to upgrade FileWay Back End and FileWay Manager to 
the current version. If this occurs, complete the upgrade by choosing to modify the current installation and then 
continue with the PSTWay installation once the upgrade has completed.  

To install PSTWay Component for OWA Servers , proceed as follows: 

1. Run PSTWay Installer.exe . The installation begins and a welcome dialog appears. 

 

2. Click Install PSTWay for Exchange 2003 to begin the installation. The following dialog appears. 

 

3. Click I accept the terms of the license agreement  and then click Next . 
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The following dialog appears. Note that the first two options should be now be unavailable if you 
already installed FileWay Back End on the same server. 

 

4. Click the PSTWay Component button and click Next . The following dialog appears. 

 

5. Enter the user name and password you created in 3.2 Creating PSTWay Admin Account on page 5. 

6. Enter the name or IP address of the designated Outlook Server on which you installed the PSTWay 
Service for Outlook Server component. Use the default Remoting Port unless port 9000 is being used 
by another application 

7. Click Next . The following dialog appears. 
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8. Click Go. The following dialog appears. 

 

9. Click Go to install the Exchange script integration engine. The following dialog appears. 
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10. Click Next . The following dialog appears. 

 

11. Select the Everyone button if you want any user to be able to run the Script Modifier executable. 
Select Just Me if you only want the user who is currently logged on to the server to be able to run the 
Script Modifier executable. 

12. Click Next to use the default location or click Browse to select a different location in which to install. 
The following dialog appears. 
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13. Click Next . The following dialog appears. 

 

After a few moments, the following dialog appears. 
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14. Click Close . The following dialog appears. 

 

15. Click Go to launch the installation of the PSTWay Component. The following dialog appears. 
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After a few moments, the following dialog appears. 

 

16. Click Next . The following dialog appears. 
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17. Click I accept the terms of the license agreement and then click Next . The following dialog appears. 

 

18. Click Next to use the default location or click Browse to select a different location in which to install. 
After a moment, the following dialog appears. 
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After a moment, the following dialog appears. Click any key to continue. 

 

After a moment, the following dialog appears. 
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19. Click Finish . The following dialog appears. 

 

20. Click Next . 

The following dialog appears confirming that you have installed all the mandatory PSTWay 
components. 
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If you use Secure Sockets Layer (SSL) and/or Forms-Based Authentication (FBA) with Exchange, it 
will be necessary to configure PSTWay to use SSL and FBA as well. Refer to Upgrading FileWay 
Components 

If the PSTWay installer detects that an older version of FileWay has already been installed on the server on 
which you are running the installer, the installer will update the FileWay components. 

4.3.4 Upgrading FileWay Back End to Version 3.4 

To upgrade FileWay Back End,  proceed as follows: 

1. Copy the PSTWay FileWay Backend Component folder to the appropriate server. 

2. Run FileWayBackEndServerSetup.exe from the PSTWay FileWay Backend Component folder. 

If the installer detects that FileWay Back End is installed on the current server, the following dialog 
appears prompting you to upgrade File Way to version 3.3. If you are not prompted to upgrade, it 
means that the current server does not have FileWay Back End installed or you do not need to 
upgrade. 

 

Click Yes. The following progress dialog appears. 
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After a few moments, the following dialog appears. 

 

3. Click Next.  The following status dialog appears. 
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After a few moments, the following dialog appears. 

 

4. Click Finish. 

At this point, FileWay Back End is updated. You should now upgrade FileWay Manager. 

4.3.5 Upgrading FileWay Manager to Version 3.4 

To upgrade FileWay Manager,  proceed as follows: 

1. Copy the PSTWay FileWay Backend Component folder to the appropriate server. 

2. Run FileWayManagerSetup.exe  from the PSTWay FileWay Backend Component  folder. 

If the installer detects that FileWay Manager is installed on the current server, a dialog appears 
prompting you to upgrade File Way to version 3.3. If you are not prompted to upgrade, it means that 
the current server does not have FileWay Manager installed or you do not need to upgrade. 
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3. Click Yes. After a few moments, the following dialog appears. 

 

4. Click Next.  The following dialog appears. 

 

5. Ensure that the Modify button is selected and click Next.  The following dialog appears. 
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6. Click Next.  The following dialog appears. 

 

7. Click Install.  The following status dialog appears. 
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After a few moments, the following dialog appears. 

 

8. Click Finish. 

At this point, FileWay Manager has been upgraded. Return to your point of origin…either Installing 
PSTWay Server Components on a Single Exchange OWA S erver  on page 11 or Installing 
PSTWay Component for OWA Servers  on page 47. 

Post-Installation Configuration Steps on page 69 for instructions describing how to configure PSTWay 
to use SSL. 

9. Click Next to continue. The following dialog appears. 
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At this point, PST Component for OWA Servers is installed. 

10. Click Finish . The following dialog appears. 

 

11. Click OK. 

12. Restart the server. 

At this point, all PSTWay components should be installed. Skip to Upgrading FileWay Components 

If the PSTWay installer detects that an older version of FileWay has already been installed on the server on 
which you are running the installer, the installer will update the FileWay components. 

4.3.6 Upgrading FileWay Back End to Version 3.4 

To upgrade FileWay Back End,  proceed as follows: 

1. Copy the PSTWay FileWay Backend Component folder to the appropriate server. 

2. Run FileWayBackEndServerSetup.exe from the PSTWay FileWay Backend Component folder. 

If the installer detects that FileWay Back End is installed on the current server, the following dialog 
appears prompting you to upgrade File Way to version 3.3. If you are not prompted to upgrade, it 
means that the current server does not have FileWay Back End installed or you do not need to 
upgrade. 
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Click Yes. The following progress dialog appears. 

 

After a few moments, the following dialog appears. 

 

3. Click Next.  The following status dialog appears. 
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After a few moments, the following dialog appears. 

 

4. Click Finish. 

At this point, FileWay Back End is updated. You should now upgrade FileWay Manager. 

4.3.7 Upgrading FileWay Manager to Version 3.4 

To upgrade FileWay Manager,  proceed as follows: 

1. Copy the PSTWay FileWay Backend Component folder to the appropriate server. 

2. Run FileWayManagerSetup.exe  from the PSTWay FileWay Backend Component  folder. 

If the installer detects that FileWay Manager is installed on the current server, a dialog appears 
prompting you to upgrade File Way to version 3.3. If you are not prompted to upgrade, it means that 
the current server does not have FileWay Manager installed or you do not need to upgrade. 
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3. Click Yes. After a few moments, the following dialog appears. 

 

4. Click Next.  The following dialog appears. 

 

5. Ensure that the Modify button is selected and click Next.  The following dialog appears. 



PSTWay Administrator’s Guide 
 

 

 

Everywhere Networks Corporation Proprietary 

68 

 

6. Click Next.  The following dialog appears. 

 

7. Click Install.  The following status dialog appears. 
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After a few moments, the following dialog appears. 

 

8. Click Finish. 

At this point, FileWay Manager has been upgraded. Return to your point of origin…either Installing 
PSTWay Server Components on a Single Exchange OWA S erver  on page 11 or Installing 
PSTWay Component for OWA Servers  on page 47. 

Post-Installation Configuration Steps. 

4.4 Upgrading FileWay Components 

If the PSTWay installer detects that an older version of FileWay has already been installed on the server on 
which you are running the installer, the installer will update the FileWay components. 
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4.4.1 Upgrading FileWay Back End to Version 3.4 

To upgrade FileWay Back End , proceed as follows: 

1. Copy the PSTWay FileWay Backend Component folder to the appropriate server. 

2. Run FileWayBackEndServerSetup.exe from the PSTWay FileWay Backend Component folder. 

If the installer detects that FileWay Back End is installed on the current server, the following dialog 
appears prompting you to upgrade File Way to version 3.3. If you are not prompted to upgrade, it 
means that the current server does not have FileWay Back End installed or you do not need to 
upgrade. 

 

Click Yes. The following progress dialog appears. 

 

After a few moments, the following dialog appears. 
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3. Click Next . The following status dialog appears. 

 

After a few moments, the following dialog appears. 
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4. Click Finish . 

At this point, FileWay Back End is updated. You should now upgrade FileWay Manager. 

4.4.2 Upgrading FileWay Manager to Version 3.4 

To upgrade FileWay Manager , proceed as follows: 

5. Copy the PSTWay FileWay Backend Component folder to the appropriate server. 

6. Run FileWayManagerSetup.exe  from the PSTWay FileWay Backend Component  folder. 

If the installer detects that FileWay Manager is installed on the current server, a dialog appears 
prompting you to upgrade File Way to version 3.3. If you are not prompted to upgrade, it means that 
the current server does not have FileWay Manager installed or you do not need to upgrade. 

7. Click Yes. After a few moments, the following dialog appears. 
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8. Click Next . The following dialog appears. 

 

9. Ensure that the Modify button is selected and click Next . The following dialog appears. 

 

10. Click Next . The following dialog appears. 
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11. Click Install . The following status dialog appears. 

 

After a few moments, the following dialog appears. 
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12. Click Finish . 

At this point, FileWay Manager has been upgraded. Return to your point of origin…either Installing 
PSTWay Server Components on a Single Exchange OWA S erver  on page 11 or Installing 
PSTWay Component for OWA Servers  on page 47. 

5 Post-Installation Configuration Steps 

5.1 Adding the PSTWay ISAPI filter to the Website i n IIS 

This configuration step is required so that once users have logged on to OWA, there is no need to re- 
authenticate when they use PSTWay. Proceed as follows: 

1. Open IIS Manager and expand Websites . 

2. Right-click the website under which Exchange is installed (which is usually the Default Website). 

3. Select Properties . 

4. Click the ISAPI Filters tab. 

5. Click the Add button. 

6. Enter a name for this ISAPI Filter, for example, PSTWay Filter. 

7. Click Browse and navigate to the following folder: \Program Files\ENC\PSTWay\PSTWay ISAPI and 
select the following file: PSTWay ISAPI.dll. 

8. Click OK twice to exit the Website properties. 

5.2 Configuring PSTWay to Use Secure Sockets Layer 

If you use Secure Sockets Layer (SSL) with Exchange, it will be necessary to configure PSTWay to use SSL as 
well. Proceed as follows: 
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1. Enable SSL on your server as described in Microsoft Knowledge base article 298805 entitled “How To 
Enable SSL for All Customers Who Interact with Your Web Site in Internet Information Services. 

2. Enable SSL on the following virtual directories: Exchange, FileWayWS, PSTBrowser, 
PSTWayWebApp using the following steps: 

a. Open Internet Information Services Manager , expand the web site, right click the virtual 
directory and select Properties . 

b. Go to the Directory Security  tab, and click Edit  in the Secure Communications  section.  

c. Select Require Secure Channel (SSL) . 

3. Set the PSTWay browse function to use SSL when talking to the FileWay backend as follows: 

Open the following file in Notepad: C:\Program Files\ENC\PSTWay\pstbrowser\web.config and 
locate the following values. 

<add key="DEWWS_DEWIO" value="http://Servername:80/FileWayWS/DEWIO.asmx"> 
</add> 
<add key="DEWWS_DBLayer" value="http://Servername:80/FileWayWS/DBLayer.asmx"> 
</add> 
 
and change them to the following: 
 
<add key="DEWWS_DEWIO" value="https://Servername:443/FileWayWS/DEWIO.asmx"> 
</add> 
<add key="DEWWS_DBLayer" value="https://Servername:443/FileWayWS/DBLayer.asmx"> 
</add> 

4. Test that SSL is enabled as follows: 

a. In a browser command line, enter: http://domain/exchange. 

A message should appear stating that the web site must be accessed using SSL.  

b. In a browser command line, enter: https://domain/exchange. 

A visual indication should appear indicating that you are accessing the web site securely. In 
Internet Explorer, the visual indication appears as a padlock: 

 

5.3 Enabling Forms Based Authentication 

If you use Forms-Based Authentication (FBA) with Exchange, it will be necessary to configure PSTWay to use 
FBA as well. Proceed as follows: 

1. Open Exchange System Manager . Expand Servers > Your servername > Protocols > HTTP . 

2. Right-click Exchange Virtual Server  and select Properties . 

3. Select the Settings  tab. 

4. Select the Enable Forms Based Authentication  check box. 
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Now when you open OWA you will see the enhanced Forms based Login screen. 

6 FileWay Concepts 

As an Administrator, you can specify access rules on an individual user basis. However, this approach can 
become unmanageable in an organization with more that 25 users. 

A more efficient approach is to specify access rules for many users at a time based on a variety of criteria. 

Both approaches are described below. 

6.1 Rule Sets 

Rule sets comprise the following elements: 

·  Members 

·  Resources 

Rule sets combine members (i.e. users) and resources to create access rules in a way that is logical for a given 
rule set. For example, a rule set called Sales could contain all employees working in the Sales department and 
would provide those employees with access to the resources that they need. 

6.1.1 Rule Set Resources 

Resources contain multiple references to folders and shares from different computers and servers. Resources 
can also contain multiple references to computers. Refer to the two following figures. 
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6.1.2 Rule Set Members 

Members can contain references to individual users and groups in your Active Directory. Rule sets can also 
contain references to other rule sets. A user can be a member of multiple rule sets. Refer to the two following 
figures. 

 

 

6.2 Individual Users 

Some users will require resources that are unique to them. In such cases, a rule set would only have one 
member; therefore, it is more practical to assign resources to those individual users. This is achieved using 
virtual machines. 

To assign resources to an individual user, you must create a virtual machine for that user. The user must 
already exist in Active Directory. Then you add resources to the virtual machine. Refer to the figure below to 
see virtual machines assigned to a user. In this example, user John Smith has a virtual machine called Special 
that contains the Specialized Equipment resource. Therefore, John would have access to that resource. 

A user may have more than one virtual machine. One reason to use multiple virtual machines is to organize 
resources in a particular way for a given user. 

Note that adding a virtual machine with resources to individual users does not preclude those users from being 
members of one or more rule sets. 
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7 Planning Access Rules for Multiple Users 

As described in the concepts section above, you have several components to work with: individual users and 
groups in your Active Directory, rule sets, folders, shares and computers. You should plan how to group these 
components. 

Begin with rule sets. Rule sets can be named according to functional groups within your organization, for 
example, Sales, Marketing , Engineering and Research could be four rule sets. The name of the rule set 
will appear to end-users as a virtual machine when they login to FileWay. Rule sets can have imbedded 
rule sets; for example, if you needed a rule set called Sales & Marketing , you could add the existing Sales rule 
set and the Marketing rule set. 

Next, decide which members should be part of a given rule set (i.e. users, groups and imbedded rule sets). 
These users and groups come from your organization’s Active Directory. For example, a rule set called Sales 
would likely contain one or more existing groups and maybe individual users or imbedded rule sets as required. 

Next, decide which resources must be added the Sales rule set. Resources are a collection of references to 
folders, shares and computers. 

Once you have planned your rule sets, members, resources and attributes, start using FileWay Manager. 

8 Making Users' PST Files Accessible in OWA 

There are a few ways to make users' PST files available to them in OWA. 

If your organization specifies users' home directories in Active Directory, instruct users to store their PST files in 
any folder within their home directory. Then, create a rule set that allows users to access their PST files and 
ensure that you select the Include Home Directories Folders check box. Refer to Creating a Rule Set  on page 
81 for the procedure for creating a rule set. This approach applies regardless of whether users' home directories 
are on their local computer or on a network server. 

If your organization does not specify users' home directories, then you have the following options: 

·  Use Active Directory to specify each user’s home directory and point the home directory to the 
location where the users store their PST files. Then, create a rule set that allows users to 
access their PST files and ensure that you select the Include Home Directories Folders  check 
box. Refer to Creating a Rule Set  on page 81 for the procedure for creating a rule set. This 
approach applies regardless of whether users' home directories are on their local computer or 
on a network server. 

·  When there is a mix of PST files stored on users’ computers and on the network, you can use a 
rule set with assignable fields to make users' PST files accessible remotely via OWA. Refer to 
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the notes below for more details about using assignable fields with rule sets. This approach is 
most effective for organizations that use consistent computer naming conventions. 

·  For users who store their PSTs on the network, you can use virtual machines to allow users to 
access their PSTs remotely via OWA. Refer to Creating Access Rules for Individual Users 
on page 93 for a description of the steps to be followed. 

A few notes about using assignable fields: FileWay Manager provides assignable fields that you can use 
when assigning resources to a rule set. The fields are: %groupname% and %username% . The following are 
examples of how you could use assignable fields when assigning resources to a rule set. 

Example using the %username% assignable field  

Some users each have their own folder on the network and the name of each folder is the same as each user’s 
user name. 

These users store their PST files in their respective folders. 

When you assign resources to a rule set, specify the %username% assignable field in the path to the resource, 
for example, \\servername\User Folders\%username%. 

From OWA, the members of the rule set will have access to their respective PST files. 

Example using the %groupname% assignable field  

Some users who are members of a group that shares a folder on the network and the name of the folder is the 
same as the name of the group. 

These users store their PST files in the shared folder. 

When you assign resources to a rule set, specify the %groupname% assignable field in the path to the resource, 
for example, \\servername\User Folders\%groupname%. 

From OWA, the members of the rule set will have access to their respective PST files. Refer to Adding Custom 
Resources to Members of a Rule Set  on page 93. 

9 Using FileWay Manager 

9.1 Starting FileWay Manager 

FileWay Manager should have been installed on the same server as the FileWay backend Server. There 
should be a short cut on the desktop to start FileWay Manager. Double-click the short cut to start FileWay 
Manager. 

 

When you first run FileWay Manager, the FileWay Manager main window appears displaying the Individual 
Users and Rule Sets icons in the left pane of the main window. 
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9.2 Stopping FileWay Manager 

To stop FileWay Manager, click File > Exit . 

You will be prompted to update the FileWay Database. If you update the FileWay Manager database, any 
changes you made since the last time the database was updated will take effect. This is important if you changed 
access privileges in some way, for example, deleting a rule set. 

If you do not update the FileWay Manager database, any changes you made since the last time the database 
was updated will only take effect the next time the FileWay Manager scheduled task is executed. 

9.3 Creating Access Rules for Multiple Users 

The general steps are as follows: 

1. Create the rule set. 

2. Add members to the rule set. 

3. Add resources to the rule set. 

Refer to the subsections below for details on each step. 

9.3.1 Creating a Rule Set 

To create a rule set, proceed as follows: 

1. Right-click the Rule Sets icon. 

A pop-up menu appears. 

2. In the pop-up menu, click Create Rule Set . 

The Create Rule Set dialog appears. 
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3. In the Virtual Machine Name field, enter a name for the rule set, for example, Sales. 

End-users will select this virtual machine to access the resources of the rule set. 

4. Click the Include Home Directories Folders check box if you want users to be able to access their 
home directory (as specified in Active Directory). 

5. Click Create Rule Set. 

The main FileWay Manager window re-appears displaying the new rule set in the right pane. 

6. Double-click the new rule set to expand it. 

The two elements of the new rule set appear: Members and Resources . Refer to the figure below. 

 

9.3.2 Adding Members to a Rule Set 

Members can be groups, users and other rule sets. 

Note: The next three procedures assume that the Members and Resources icons appear in the left and right 
panes for the selected rule set as shown in the previous figure. If necessary, expand the Rule Sets icon and/or 
the rule set you want to modify. 

9.3.2.1 Adding Groups to a Rule Set 

1. Right-click Members . 

A pop-up menu appears. 

 

2. From the pop-up menu, click Edit Group List . 

The Edit Group List dialog appears. Use this dialog to search for the group(s) you need, for 
example, Sales. 
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3. Select the Domain from which you want to add a group. 

Note: Before you can select trusted domains, you must first add the trusted domains to the FileWay 
domain list. Refer to Adding Trusted Domains  on page 97. 

4. In the Starts With field of the Edit Group List dialog, enter the name of the group you want and click 
Search to find the group in Active Directory. 

If you prefer to browse for the group name, enter nothing in the Starts With field and click Search . 
The result of the search appears below the Search Results list. 

5. Select one or more groups you want, and click Add Groups . You can also double-click a group to 
select it. 

The selected groups appear in the Members list. 

6. Click OK when you have selected all the groups you need. 

The main FileWay Manager window reappears displaying the group(s) you just added. The domain to 
which the group belongs also appears. 
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9.3.2.2 Adding Users to a Rule Set 

The process for adding users is almost identical to adding groups. From the Members pop-up menu, select 
Edit User List and the Edit User List dialog appears. From that point, the process is the same as adding 
groups. 

9.3.2.3 Adding Other Rule Sets to a Rule Set 

The process for adding rule sets to another rule set is almost identical to adding groups. From the Members 
pop-up menu, select Edit Rule Set List and the Edit Rule Set List dialog appears. From that point, the 
process is the same as adding groups. 

In the figure below, you can see that the Students rule set is imbedded into the Test rule set. This means that 
users who are members of the Students rule set can also access the resources specified in the Test rule set. 

 

9.3.3 Adding Resources to a Rule Set 

There are two approaches to specifying resources within a rule set: 
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·  You may specify a computer, share or a folder within a share to be accessible by all members 
of the ruleset. 

·  You may specify a custom resource with fields that are replaced when the resource is written to 
the FileWay database. 

9.3.3.1 Assigning Resources to Members of a Rule Se t 

Proceed as follows to add resources to your rule set: 

Note: This procedure assumes that the Members and Resources icons appear in the right and left panes for the 
selected rule set as shown below. If necessary, expand the Rule Sets icon and/or the rule set you want to 
modify. 

 

1. Right-click Resources and select Add Resources from the pop-menu. 

The Add Resources dialog appears. 

 

2. Expand the various items in the left pane until you locate the folder(s), share(s) or computer(s) that are 
applicable to your rule set. 

3. To select a resource from this dialog, right-click the resource and click Add Resources . 
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The main FileWay Manager window re-appears displaying the resource you added in the right pane. 

 

Note: When you add a computer to a rule set’s resources, only the computer’s shares will be accessible to the 
members of the rule set. In addition, the computer will appear to users as a network drive icon instead of a 
computer icon. 

At this point, you have created a rule set containing users and resources. Repeat the process to create more 
rule sets. 

9.3.3.2 Assigning Custom Resources to Members of a Rule Set 

FileWay Manager provides assignable fields that you can use when assigning resources to a rule set. The fields 
are: %groupname% and %username% . 

This approach simplifies the creation of custom rule sets for individual groups or users; without the fields, you 
would need to create a separate rule set for each user and/or group. 

For examples of how you may use assignable fields, refer to Making Users' PST Files Accessible in OWA  on 
page 79. 

Proceed as follows to add custom resources to your rule set: 

Note: This procedure assumes that the Members and Resources icons appear in the right and left panes for the 
selected rule set as shown below. If necessary, expand the Rule Sets icon and/or the rule set you want to 
modify. 

 

1. Right-click Resources and select Add Custom Resource from the pop-menu. 

The Add Custom Resource dialog appears. 
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2. Browse to the location of the resource you want to add. 

3. Once the path to the resource appears in the field at the bottom of the Add Custom Resource dialog, 
type a backslash at the end of the path. 

4. Click %username% to insert the user name field in the resource path. This will be replaced by the 
current user name when the rule set information is written to the FileWay database. Click 
%groupname% to insert the group name field in the resource path. This will be replaced by the 
current group name when the rule set information is written to the FileWay database. 

The main FileWay Manager window re-appears displaying the resource you added in the right pane. 

 

9.4 Viewing Members of a Rule Set 

Within of a rule set, you can view the members of groups and the members of imbedded rule sets. In the figure 
below, you can see that the Engineering rule set is imbedded into the Sales rule set. 

Note: The following procedures assume that the rule set members appear in the right pane as shown below. If 
necessary, expand the Rule Sets icon and/or the rule set for which you want to view the members. 

 

9.4.1 Viewing Members of Group within a Rule Set 

To view the members of a group within a rule set, proceed as follows: 
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1. Double-click the group for which you want to see the members. 

2. A dialog appears showing the users who are members of the selected group. 

3. Click OK to close the window. 

The main window reappears showing the members of the current rule set. 

9.4.2 Viewing Members of a Rule Set within a Rule S et 

To view the members of an imbedded rule set, proceed as follows: 

1. Double-click the imbedded rule set for which you want to see the members. 

2. A window appears showing the users that are members of the selected imbedded rule set. 

3. Click OK to close the window. 

The main window reappears showing the members of the current rule set. 

9.5 Modifying Rule Sets 

You can make the following changes to a rule set: 

·  Change characteristics of the rule set itself 

·  Change its Members 

·  Change its Resources 

Note 1: When you make any changes in FileWay Manager, and you want the changes to take effect 
immediately, update the FileWay database by selecting the following command from the Tools menu: Write 
Configuration to FileWay Database . 

Note 2: The following procedures assume that the rule sets appear in the left pane as shown in the following 
figure. If necessary, expand the Rule Sets icon. 

 

9.5.1 Changing Characteristics of Rule Sets 

You can make the following changes to a rule set: 

·  Rename 

·  Delete 

·  Change properties 
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9.5.1.1 Renaming a Rule Set 

To rename a rule set, proceed as follows: 

1. Right-click the rule set you want to rename. 

A pop-up menu appears. 

 

2. From the pop-up menu, click Rename Rule Set . 

The name of the rule set is highlighted. 

 

3. Type the new name for the rule set and press Enter.  

9.5.1.2 Deleting a Rule Set 

To delete a rule set, proceed as follows: 

1. Right-click the rule set you want to delete. 

A pop-up menu appears.  

2. From the pop-up menu, click Delete Rule Set . 

A verification dialog appears asking you to confirm the deletion.  

3. Click Yes. 

The rule set is removed from the list of rules sets. 

9.5.1.3 Changing Rule Set Properties 

To rule set properties, proceed as follows: 

1. Right-click the rule set whose properties you want to change. 

A pop-up menu appears. 
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2. From the pop-up menu, click Properties . 

The Rule Set Properties dialog appears.  

3. Select or deselect the Include Home Directories check box if you want users to be able to access 
their home directory (as specified in Active Directory). 

4. Click OK. 

The main FileWay Manager window re-appears. 

9.5.2 Changing Members of a Rule Set 

Members can be groups, users and other rule sets. 

Note: The following procedures assume that the rule set members appear in the right pane as shown below. If 
necessary, expand the Rule Sets icon and/or the rule set you want to modify. 

 

9.5.2.1 Deleting a Single User from a Rule Set 

To delete a user from a rule set, proceed as follows: 

1. Right-click the user that you want to delete and select Delete Members . 

A verification dialog appears asking you to confirm the deletion.  

2. Click Yes. 

The main FileWay Manager window re-appears displaying the remaining members in the right pane. 

9.5.2.2 Adding or Deleting Multiple Users to or fro m a Rule Set 

To add and/or delete multiple users from a rule set, proceed as follows: 

1. Right-click Members  in the left pane. 

A pop-up menu appears.  

2. From the pop-up menu, click Edit User List . 

The Edit User List dialog appears displaying users that are already members of the rule set.  
 
Use this dialog to search for the user(s) you need.  
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3. In the Starts With field of the Edit User List dialog, enter the name of the user that you want to add. 

If you prefer to browse for the group name, enter nothing in the Starts With field and click Search .  
 
The result of the search appears below the Search Results list.  

4. Select one or more users that you want, and click Add Users . You can also double-click a user to 
select it. 

The selected users appear in the Members list.  

5. You can delete multiple users from the rule set by selecting them in the Members list and clicking 
Remove . A verification dialog will appear asking you to confirm the deletion. 

6. Click OK in the Edit User List dialog when you have selected all the users you need. 

The main FileWay Manager window reappears displaying the users(s) you added. 

9.5.2.3 Deleting a Single Group from a Rule Set 

To delete a group, proceed as follows: 

1. Right-click the group that you want to delete and select Delete Group . 

A verification dialog appears asking you to confirm the deletion.  

2. Click Yes. 

The main FileWay Manager window re-appears displaying the remaining members in the right pane. 

9.5.2.4 Adding or Deleting Multiple Groups to or fr om a Rule Set 

The process for adding and/or deleting multiple groups is almost identical to adding and/or deleting multiple 
users. From the Members pop-up menu, select Edit Group List and the Edit Group List dialog appears. 
From that point, the process is the same as adding and/or deleting multiple users. 

9.5.2.5 Deleting a Single Rule Set from a Rule Set 

To delete a rule set within a rule set, proceed as follows: 

1. Right-click the rule set that you want to delete and select Delete Rule Set . 

A verification dialog appears asking you to confirm the deletion.  

2. Click Yes. 

The main FileWay Manager window re-appears displaying the remaining members. 

9.5.2.6 Adding or Deleting Multiple Imbedded Rule S ets to or from a Rule Set 

The process for adding and/or deleting multiple rule sets within one rule set is almost identical to adding and/or 
deleting multiple users. From the Members pop-up menu, select Edit Rule Set List and the Edit Rule Set List 
dialog appears. From that point, the process is the same as adding and/or deleting multiple users. 
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9.5.3 Changing Resources of a Rule Set 

Note: The following procedures assume that the rule set members appear in the right pane as shown below. If 
necessary, expand the Rule Sets icon and/or the rule set you want to modify. 

 

9.5.3.1 Deleting a Single Resource from a Rule Set 

To delete a resource, proceed as follows: 

1. Right-click the resource that you want to delete and select Delete Resources . 

A verification dialog appears asking you to confirm the deletion.  

2. Click Yes. 

The main FileWay Manager window re-appears displaying the remaining resources. 

9.5.3.2 Adding Resources to a Rule Set 

To add a resource to a rule set, proceed as follows: 

1. Within the relevant rule set, right-click Resources and select Add Resources from the pop-menu. 

The Add Resources dialog appears.  

2. Expand the various items in the left pane until you locate the folder(s), share(s) or computer(s) that are 
applicable to your rule set. These would be resources that only members of the rule set may access. 

3. To select a resource from this dialog, right-click the resource and click Add Resources . 

The main FileWay Manager window re-appears displaying the resource you added.  

 

4. Repeat until you have selected all the resources you need. 
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Note: When you add a computer to a rule set’s resources, only the computer’s shares will be accessible to the 
members of the rule set, more specifically, the FileWay end-users. In addition, the computer will appear to end-
users as a network drive icon instead of a computer icon. 

9.5.3.3 Adding Custom Resources to Members of a Rul e Set 

FileWay Manager provides assignable fields that you can use when assigning resources to a rule set. The fields 
are: %groupname% and %username% . 

This approach simplifies the creation of custom rule sets for individual groups or users; without the fields, you 
would need to create a separate rule set for each user and/or group. 

For examples of how you may use assignable fields, refer to Making Users' PST Files Accessible in OWA  on 
page 79. 

Proceed as follows to add custom resources to your rule set: 

1. Right-click Resources and select Add Custom Resource from the pop-menu. 

The Add Custom Resource  dialog appears.  

2. Browse to the location of the resource you want to add. 

3. Once the path to the resource appears in the field at the bottom of the Add Custom Resource dialog, 
type a backslash at the end of the path. 

4. Click %username% to insert the user name field in the resource path. This will be replaced by the 
current user name when the rule set information is written to the FileWay database. Click 
%groupname% to insert the group name field in the resource path. This will be replaced by the 
current group name when the rule set information is written to the FileWay database. 

The main FileWay Manager window re-appears displaying the resource you added in the right pane.  

5. Repeat until you have added all the custom resources you need. 

9.6 Creating Access Rules for Individual Users 

Sometimes, rule sets may not the best approach for assigning resources to a user. In this case, you can assign 
resources to individual users. 

To assign resources to individual users, you must create one or more virtual machines for each individual user. 
The user must already exist in Active Directory. Then you add resources to the appropriate virtual machine. 
One reason to use multiple virtual machines per user is to group the resources in a particular way. Refer to the 
figure below to see virtual machines assigned to individual users. 
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When users attach a PST file in OWA, they will need to search for it. When they do, they will need to locate the 
virtual machine you created using FileWay Manager. The Virtual Machine will appear as shown in the figure 
below. 

 

The general steps for creating access rules for individual users are as follows: 

1. Add the user in FileWay. 

2. Add a virtual machine to the user. 

3. Add resources to the virtual machine. 

Refer to the subsections below for details on each step. 

9.6.1 Adding a User 

To add an individual user, proceed as follows: 

1. Right-click the Individual Users icon. 

A pop-up menu appears.  

2. In the pop-up menu, click Edit User List . 

The Edit User List dialog appears displaying a list of users who already have had resources 
assigned directly to them.  
 
Use this dialog to search for the user that you want to add. 

3. In the Starts With field of the Edit User List dialog, enter the name of the user you want and click 
Search to find the user in Active Directory. 
 
If you prefer to browse for the user name, enter nothing in the Starts With field and click Search . 
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The result of the search appears in the Search Results list. 

4. Select one or more users you want, and click Add Users . You can also double-click a user to select it. 

The selected user(s) appear in the Members list.  

5. Click OK when you have selected all the users you need. 

The main FileWay Manager window reappears displaying the user(s) you just added. 

9.6.2 Adding a Virtual Machine to a User 

To add a virtual machine to a user, proceed as follows: 

1. Right-click the relevant user. 

A pop-up menu appears.  

2. From the pop-up menu, click Add Virtual Machines . 

The Add Virtual Machines  dialog appears.  

3. Click Create Virtual Machine . 

The Create Virtual Machine  dialog appears.  

4. Enter the name of the Virtual Machine . 

5. Click Create Virtual Machine . 

The name of virtual machine appears below the user.  

You may add as many virtual machines as required. 

9.6.3 Adding Resources to a Virtual Machine 

To add a resource to an individual user’s virtual machine, proceed as follows: 

1. Right-click a virtual machine and select Add Resources from the pop-up menu. 

The Add Resources dialog appears.  

2. Expand the various items in the left pane until you locate the folder(s), share(s) or computer(s) that are 
applicable to the user. 

3. To select a resource from this dialog, right-click the resource and click Add Resources . 

The main FileWay Manager window re-appears displaying the resource you added.  

4. Repeat until you have selected all the resources you need. 

Note: When you add a computer to a rule set’s resources, only the computer’s shares will be accessible to the 
relevant FileWay end-user. In addition, the computer will appear to end-users as a network drive icon instead of 
a computer icon. 



PSTWay Administrator’s Guide 
 

 

 

Everywhere Networks Corporation Proprietary 

96 

9.6.4 Deleting a User 

To delete an individual user, proceed as follows: 

1. Right-click the user you want to delete. 

A pop-up menu appears.  

2. In the pop-up menu, click Delete User . 

A confirmation dialog appears.  

3. Click Yes to confirm the deletion. 

The main FileWay Manager window reappears displaying the remaining user(s). 

9.6.5 Renaming a User's Virtual Machine 

To rename a user’s virtual machine, proceed as follows: 

1. Right-click the virtual machine that you want to rename. 

A pop-up menu appears.  

2. From the pop-up menu, click Rename Virtual Machine . 

The name of the rule set is highlighted.  

3. Type the new name for the rule set over the old and press Enter.  

9.6.6 Deleting a User's Virtual Machine 

To delete an individual user’s virtual machine, proceed as follows: 

1. Right-click the user you want to delete. 

A confirmation dialog appears.  

2. Click Yes to confirm the deletion. 

The main FileWay Manager window reappears displaying the remaining virtual machines. 

9.6.7 Deleting a Resource from a User's Virtual Mac hine 

To delete a resource, proceed as follows: 

1. Display the user’s resources in the right pane of FileWay Manager. You may need to expand the 
user’s name and possibly double-click the virtual machine name. 

2. Right-click the resource that you want to delete and select Delete Resources . 

A verification dialog appears asking you to confirm the deletion.  

3. Click Yes. 
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The main FileWay Manager window re-appears displaying the remaining resources. 

10 Managing the FileWay Database 

10.1 Adding Trusted Domains 

When creating rule sets, you can choose users, groups and resources from trusted domains within your 
organization; however, before you can access trusted domains from within FileWay, you must add the trusted 
domains to the list of domains that FileWay can use. 

Proceed as follows: 

1. Click Tools > Domain List . 

 

The following dialog appears listing all the trusted domains within your organization. The host domain 
is the one in which FileWay is installed.  

 

2. Select the trusted domain you want and click Add Domains . 

3. Click OK to finish. 

10.2 Viewing the Current Contents of the Database 

Select Tools > Show FileWay Database to get a quick and complete view of all rule sets and their members 
and resources, as well as individual users and their virtual machines and resources. Refer to the figure below. 
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Note that you should update the FileWay Manager database before viewing the contents of the database in this 
manner. Viewing the database in this way allows you to quickly check whether changes you made in FileWay 
Manager were written to the database. 

Viewing the database is useful for debugging purposes, for instance, to check if a certain user has access to a 
certain resource. 

 

10.3 Scheduling Daily Updates for FileWay Manager D atabase 

You can configure FileWay Manager to automatically update the FileWay Manager database on a scheduled 
basis. Click Tools > Schedule FileWay Database Updates and the following dialog appears. 

 

Select the schedule that suits your requirements and click OK. 

Note if you choose to schedule updates to the database, keep in mind that if you make changes in FileWay 

Manager that must be applied immediately, use the procedure in the next section. 
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10.4 Updating the Database with Latest Changes 

When you make any changes in FileWay Manager, and you want the changes to take effect immediately, update 
the FileWay database by selecting the following command from the Tools menu: Write Configuration to 
FileWay Database . 

If changes are made to Active Directory that impact FileWay, for example, removal of users or groups, run Write 
Configuration to FileWay Database . If you find that the changes were not propagated to FileWay Manager, 
Active Directory will need to be closed and re-opened. 

11 PSTWay End-User Notes 

This section describes an OWA user’s view of PSTWay. 

11.1 Attaching PST file 

1. To attach a PST file to OWA, click the Options button in the left bottom pane of OWA. The following 
pane appears within OWA. If prompted, enter your domain username and password. 

 

2. Click the Browse button and find the PST file. 
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3. Once you have found the PST file, select the filename and click Add PST . The window is refreshed 
and the filename appears the PST UNC Path field. 

 

4. Alternatively, you can enter the UNC path to the PST file directly into the PST UNC Path field, for 
example, \\servername\sharename\filename.pst. 

5. If the PST file is password-protected, enter the password in the PST Password field. 

6. Click the Add button. The folder list on the left upper pane is refreshed automatically and the new PST 
file is displayed in the list below the PSTWay folder. 



PSTWay Administrator’s Guide 
 

 

 

Everywhere Networks Corporation Proprietary 

101 

 

You may add more PSTs if necessary. 

Note : If you want remove a PST from the list of added PST files, do not delete it from the folder list; 
instead, refer to Removing a PST File  on page 102. If you delete the PST from the folder, you will be 
actually deleting the entire PST file. 
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11.2 Viewing PST File 

To view the contents of the PST file, expand the PSTWay folder on the left upper pane. All attached PST files 
should appear. Expand a PST filename to view its contents. If prompted, enter your domain username and 
password. 

 

11.3 Adding and/or Removing Contents in the PST Fil e 

Once you have attached a PST file, you can add items like email messages or contacts to it. You can do this by 
dragging an item from an OWA folder into the corresponding folder in the PST. 

You can delete items from an attached PST, which will permanently remove the item from the PST file. You can 
reply to and forward messages from the PST. Finally, you can edit contacts etc. and save the changes 

Note: If you want to remove a PST, do not delete it from the folder list; instead, refer to Removing a PST File  on 
page 102. If you delete the PST from the folder, you will be actually deleting the entire PST file. 

11.4 Removing a PST File 

When you no longer want a PST file to be attached in OWA, you can remove it as follows. 

1. Click the Options  button. If prompted, enter your domain username and password. 

2. Select the PST file in the listing of attached files. 
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3. Click the Remove button. The folder list is refreshed automatically after this change and you will see 
that the PST file is gone. 

Note: Removing a PST file does not delete the PST file from its saved location; removing a PST file simply 
makes the file inaccessible from OWA. 

12 Troubleshooting 

If, after installing a hot fix or service pack for Exchange Server 2003, you notice changes in how PSTWay 
functions, it is possible that some PSTWay scripts may have been overwritten during the upgrade. You may 
notice that you are missing some of the functionality of PSTWay in OWA. The figure below shows an example of 
the PSTWay functions on the Options page. If PSTWay scripts were overwritten by an Exchange update, this 
section may be missing. In this case, you will need to run the Script Modifier to repair the overwritten files. It is not 
necessary to run the Script Modifier after each Exchange Server upgrade; it only needs to be run if PSTWay 
loses functionality. 
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If you need to run the Script Modifier, execute the following: 

Program files\enc\encscriptmodifier\Pstwayinstall.b at 

A Command Prompt window will open showing the script being executed. 

When the script finishes, press any key the command window and the scripts will be updated. 

 

 


